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Preparing for DVD
By Edward Troxel

Creating DVDs used to be a complicated and expen-
sive process that only Hollywood could create. Today,
with writable DVD technology, anyone with the proper
tools can create DVDs. In fact, all that is needed is a
copy of Vegas + DVD and a DVD burner.

The first step to creating a DVD is to capture and
edit your video. Usually, you will print this video to
tape for archival purposes and the creation of VHS cop-
ies. At this point, you are ready to begin the DVD cre-
ation process.

To fit on a DVD, the video must be compressed. The
compression used is called MPEG-2. While DV is al-
ready compressed at a rate of 5:1, MPEG-2 allows much
greater compression. It also allows various rates of com-
pression leting you find a balance between quantity and
quality. While you can fit three hours of footage onto a
DVD, it will not look as good as only putting on one
hour of video because it must be compressed at a much
higher rate.

To get your video into MPEG-2 format, you need to

choose Render As from the File Menu. On this screen,
you would pick the MainConcept MPEG-2 as the Save
As Type. In the Template box you will find several pre-
defined choices - many specifically designed for use with
DVD Architect. Pick the template appropriate for your
video such as DVD Architect NTSC Video Stream.
Clicking on Save would then create an MPEG-2 file
using the default settings.

While these settings will work for a typical video of
one hour or less, there may be times when some of the
settings need to be modified. Click on Custom to dis-
play the settings. On the video tab you will find options
for changing how much the file is to be compressed.
This is determined by the bitrate selected.

The first option is to use either “Constant Bit Rate
(CBR)” - which will render every frame of the video
with the same number of bits - or “Variable Bit Rate
(VBR)” - which
will use more
bits for areas
with lots of ac-
tion and fewer
bits for areas
with less action. It is generally recommended that VBR
be used for longer videos. For the sake of simplicity, it
is easier to use VBR every time.

Next, the bitrate needs to be determined. When us-
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ing VBR, there are three bitrates to be defined: Maxi-
mum, Average, and Minimum. With the DVD Architect
templates, these default to 8,000,000, 6,000,000, and
192,000 respectively. These are good starting values and
will allow videos up to about 1.5 hours. As a personal
preference, I usually change the minimum value to
2,000,000 as shown in the picture.

Depending on the length of the video, the Average
value may need to be adjusted. Another factor is the
type of audio. AC-3 (Dolby) audio is very compressed
while PCM (WAV) audio is not compressed. Finally,
enough room must be left over to hold the menus. Un-
less the menus are extremely complicated, they usually
take very little space.

Formulas have been developed to help determine an
approximate average bitrate. For example, if you are
using AC-3 audio at 192 Kbps, the formula is:
(36096 - (((# Minutes * 60) * 192) / 1024 )) / (# Minutes * 60)
meaning that if your video is 1 hour 40 minutes (a total
of 100 minutes) you would use:
(36096 - (((100 * 60) * 192) / 1024)) / (100 * 60)=5.829
meaning you can use an average bitrate of around
5,800,000. If you are using PCM audio, the formula is:
(36096 - (((# Minutes * 60) * 1600) / 1024)) / (# Minutes * 60)
meaning that same 100 minute video would need an
average bitrate around 4,450,000. As you can see, us-
ing AC-3 audio will allow the bitrate to be significantly
higher.

To get a compliant MPEG-2 file, just render as
MPEG-2 format using any of the DVD Architect pre-
sets. Then choose custom and modify the average bitrate
to be appropriate for the length of your video.

Another option you may wish to pick on the Render
As screen is Save project markers in media file. First,
place markers on the timeline wherever you want chap-
ter points and choose this option when rendering. Then,
when the file is loaded in DVD Architect the markers
will automatically become chapter points. This is an
easy way to set and name chapter points directly on the
Vegas timeline.

Approximate Bitrates Needed
(based on length of video & type of audio)

AC-3 PCM
Len. in Minutes Max Rate Max Rate
30 8.000 8.000
45 8.000 8.000
60 8.000 8.000
70 8.000 7.032
75 7.834 6.459
80 7.333 5.958
85 6.890 5.515
90 6.497 5.122
95 6.145 4.770
100 5.829 4.454
105 5.542 4.167
110 5.282 3.907
115 5.044 3.669
120 4.826 3.451
125 4.625 3.250
130 4.440 3.065
135 4.269 2.894
140 4.110 2.735
145 3.961 2.586
150 3.823 2.448
155 3.694 2.319
160 3.573 2.198
165 3.459 2.084
170 3.351 1.976
175 3.250 1.875
180 3.155 1.780

At this time, rendering for DVD is a two step pro-
cess. Once the video has been rendered, it is now time to
render the audio. If you are using PCM audio, just ren-

der the audio to a WAV file. For AC-3 audio, the stan-
dard DVD Stereo option is 192 Kbps at 48,000 Hz.

After these steps, you will have an MPG file and
either a WAV file or an AC3 file. These files can then be
loaded into DVD Architect - or some other authoring
program - to finish the DVD creation process.
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Beginner’s Corner - Beginning Editing
By Edward Troxel

 Whether you are new to video editing or moving to
Vegas from some other program, there are many tasks
that are fundamental to editing. From the simplistic to
the complicated, all NLE’s will do the basic operations
of cutting clips, adding dissolves, and adding other spe-
cial effects. What must be learned is how Vegas handles
those tasks.

For example, a frequent question is “How do I cut a
clip into pieces?” In this case, the short answer is to
click on the event(s) to split at the position where the
split is to occur and press the “S” key.

When splitting, there are a few rules to note. If there
are no events selected, all events under the cursor will
be split. If you have an event selected but it is not under
the cursor, no events will be split. Finally, if there is an
event selected and it is under the cursor, only the se-
lected events will be split.

Now suppose the cursor is positioned where you want
a clip split but that clip is not selected. An easy way to
select the clip
without moving
the cursor is to
hold down the
CTRL key and
then click on the
clip. Now you can safely press “S” to split that clip.
Other selection options include pressing CTRL-A to
select all clips or CTRL-SHIFT-A to deselect all clips.

Splitting allows unwanted sections of video to be
deleted. To delete a segment of video, simply split on

both sides of the un-
wanted segment.
Now, select the
video to remove and
press the “Delete”
key. Then select the
matching audio and
press the “Delete”
key. By requiring
both to be deleted

individually, it is possible to easily remove only the video
or audio from the clips. However, it does require you to

delete twice when wanting to remove both the audio and
the video.

Now that the unwanted segment is removed, it is very
simple to create a crossfade between the two remaining
clips. Crossfades are created automatically by overlap-
ping the two
clips. The larger
you make the
overlap, the
more time will
be used to do the crossfade. As the clips touch, an “X”
will appear indicating the crossfade area.

The “X” actually indicates the type of crossfade used.
Notice how the video and audio “X’s” are slightly dif-
ferent in the image above. The lines indicate how quickly
or slowly the video will appear or fade. There are many

different types of fades available. To see the different
types, right-click the crossfade area and choose Fade
Type. By selecting the proper type, you have full con-
trol over how the transition occurs.

Fade In’s and Fade Out’s are just as easy to create.
Move the mouse to the upper left-hand corner for a fade
in or upper right-hand
corner for a fade out. The
mouse image will turn
into a quarter-pie shape.
When the mouse is that
shape, click and drag toward the center of the clip and
the fade is created. Once again, the farther you drag, the
longer the fade. As shown above, the length of the fade
will be displayed in a yellow box. This value will change
in real-time as you resize the fade.

Even though cuts and crossfades should account for
about 99.999% of all transitions, there may be occa-
sions when a fancier transition is needed. Vegas is not in
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short supply when it comes to additional transitions.
Click on the Transitions tab on the lower left side of the
Vegas screen
to see a list of
what is avail-
able. Choose
the transition
you want be-
tween the
clips and
drag it to the
crossfade area. The crossfade will now be the chosen
transition.

Dropping the transition onto the crossfade causes the
configuration
dialog to be
d i s p l a y e d .
Here you can
fine-tune how
the transition
will look. Ad-
just the set-
tings as de-
sired and
close the con-
figuration box. The transition name will now appear in

the crossfade area. Not only
will this help you remember
which special transition was
used, the “X” on the right

side of the name also allows opening the configuration
box should additional changes be needed.

To see how the newly
added transition will
look, just play the time-
line and the transition
will be played back in
real-time. To see it in
more detail, use the ar-
row key to advance along
the timeline.

As we just saw, the difference between crossfades
and fades were very minor. They
both look and behave in a similar
manner. In fact, they are so simi-

lar that transitions can also be dropped onto fades. With
this ability, fading in and out can be highly customized
and span multiple tracks as needed.

A third area of confusion is related to adding text
over the video. A common problem is having the text
display in place of the video
instead of as an overlay on
top of the video. There are
only two things to learn in
order to get the text displayed
correctly.

The first thing to learn about placing text is to choose
one of the presets with a “checkerboard” background.

The checker-
board indicates a
t r a n s p a r e n t
background al-
lowing the video
to show behind
the title.

The second thing to learn is to place the text media
on a track above the video track. A common mistake is
placing the text
on the same track
as the video. Do-
ing that will
cause the text to
actually replace
the video.

I hope this helps with getting started with Vegas. Send
me a note and let me know the types of things you would
like to see included in this column.
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Authoring a DVD in DVD Architect
By Edward Troxel

 After using Vegas to edit your video and render the
MPEG-2 file, it is time to author the DVD. “Author-
ing” refers to the creation of menus, chapter points, and
all of the other processes necessary to create DVD com-
pliant files. Once the files are created, they can be writ-
ten to a blank DVD for viewing on any compatible DVD
player.

After starting DVD Architect, you can choose be-
tween four different types of projects. By default, DVD
Architect opens starting a new Menu Based DVD. Other

options are a Single Movie, Picture Slideshow, and
Music Compilation DVD. If you simply want to insert
the DVD and have it play the movie, for example, choose
to create a Single Movie DVD. For this article, I will be
creating a Menu Based DVD.

To add a movie to the DVD, locate the rendered
MPEG-2 or AVI file in the Explorer window and drag it

to the menu dis-
play area as
shown here. At
this point, we
have already
created a DVD
menuing system
that has one but-
ton which will
play the entire
movie. In fact,
click on the

“Preview” button and you can see how the menu will
look. Click on the menu option we created and the movie
will start playing. Click on “Close” to return to the menu
editing screen.

Chapter points and menus are also easily created. If
you placed markers on the timeline and rendered with
the “Save project markers in media file” option

checked, you have already defined the chapter points. If
you did not set the markers in Vegas, you can still manu-
ally define the chapter points. To do so, start by double-
clicking on your current menu item.

This timeline is very similar to Vegas’ timeline. You
can zoom in or out, navigate using the arrows, play and

stop, and, more importantly, press “M” to add markers
to be used as chapter points. Insert and name chapter
points as needed.

While on this screen,
you will also see where the
video and audio files are
defined. If you wish to use
a separate audio file, sim-
ply drag the audio file from the explorer window to the
Audio box. The filename will then change to the se-

lected file. When finished, click on the up arrow to re-
turn to the menu.

Now that the chapter points have been defined, cre-
ating one or more
menus with links
to those chapter
points is very
simple. When
you right-click
the menu button,
a menu will ap-
pear. Select “In-
sert Scene Selec-
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tion Menu” and one or more new menus will be created
containing links to each of the chapter points. When
one of these new menu buttons are selected, play will
begin at that chapter point and continue through the end
of the video.

Depending on the number of chapter points defined

and the number of items specified to be placed on each
selection menu, one or more selection menus may be
created. Notice that arrows to the next and previous
menus will be automatically added to the Scene Selec-
tion menus. If you wish chapter points to be on a differ-
ent menu, simply use Window’s Cut, Copy and Paste
commands to copy
or move the a menu
button to a different
menu.

Now that the
menu buttons have
been defined, it is
time to fine-tune
how they each look.
After selecting a
menu button, con-
figure that button
using the Object tab.
In the top section
you can define the
picture to appear in
the button. This can
be a frame from the
video, a frame from
any other video, or

a separate picture. If using video, you can also specify
the video is to loop.

In the middle section, you can specify whether or not
you want a frame around your button. If you do want a
frame, you can also specify which frame to be used.
Just click on the arrow beside the frame picture and a
list of available frames will be presented.

In the bottom area, you can define whether the but-
ton is to be a picture, text, or both. By default you get
both. If desired, you can turn off the picture or text por-
tion of the buttons.

Each menu also has a series of page properties. In
the top box, you can
specify what is to ap-
pear in the back-
ground behind the but-
tons. By default, this
is “From theme.”
However, you can
specify any picture or
video allowing a per-
sonalized or moving
background.

A separate audio
file can also be speci-
fied. This audio will
be played while the menu is displayed.

In the middle section, how the selected item gets high-
lighted can be modified. Several different options are
available. The opacity of the selected option can also be
adjusted.

The bottom section will allow the background video
and music to be looped. However, this also specifies the
length of time that video in motion buttons on that menu
will be looped. In other words, all items on one menu
will be looped for the same amount of time. Therefore,
you must be careful when adding looped items to verify
they are the same length. Otherwise, you may end up
with black frames or silence waiting for the other piece
to finish looping.

DVD Architect can be used to create advanced DVDs.
While it may still lack a few features, it still has a very
large feature set. Experiment with the options and you
will be creating DVDs with motion menus, motion back-
grounds, and other sophisticated features.


